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FrameMaker vs. Word in a Nutshell

Overview

Our clients frequently ask us to recommend a desktop publishing application to use 
for their documentation. We freely admit that we are biased�we prefer Adobe 
FrameMaker over Microsoft Word. Our bias is based on our experience using both 
tools for several years, observing how our clients use these tools, and fixing broken 
documents. 

This document is a detailed technical comparison between Microsoft Word 2000 and 
Adobe FrameMaker 6.0. We will evaluate and compare their features, benefits, and 
pitfalls.

Goals of this Document

This document attempts to answer the following questions:

▼ Which tool should I use for my documents?

▼ Why should I use FrameMaker instead of Word for product manuals?

▼ How do I justify using FrameMaker to my manager?

▼ I have no choice�I must use Word (or FrameMaker). What are the tool�s strengths 
and weaknesses?

About the Comparison

Items contained in this paper were tested using Adobe FrameMaker 6.0 and Microsoft 
Word 2000 on the Windows 2000 platform. The functionality for FrameMaker is 
essentially the same on the Macintosh and UNIX platforms. The functionality of Word 
2001 for the Macintosh is roughly equivalent to Word 2000 for the PC.

Credits and Contacts

This document is primarily the work of Ellen Levy Finch and Marie Novicki of Expert 
Support, Inc. (ESI) in Mountain View, CA. Other ESI writers and managers have also 
contributed based on their experiences with both products.

To contact Expert Support:

▼ By email: webInquiry@xs.com 

▼ By telephone: (650) 941-9778
2 Word 2000 vs. FrameMaker 6.0
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Choosing the Right Tool

In this section we discuss some of the issues to consider when selecting the 
appropriate tool for your document.

Word Processing vs. Desktop Publishing

In the industry in general, Word is considered to be a �word processor� along with 
such tools as WordPerfect and WordStar, whereas FrameMaker is considered a 
�desktop publishing tool,� along with such tools as PageMaker and Interleaf. Both 
types of tools allow you to enter and format text, insert or create graphics, and apply 
different fonts and font characteristics, although some word processing tools are 
limited in the graphics area. 

The primary difference between word processing tools and desktop publishing (DTP) 
tools is control. DTP tools provide the user with finer control over layout, graphics, 
color, and output types. Word processing tools either provide limited capabilities in 
these areas or do not support them

When deciding whether to use FrameMaker or Word, consider the amount of control 
you need over the elements of your documents. If you need more control, choose 
FrameMaker.

What Size Is Your Document?

Are you working on small, simple documents, such as memos or short papers? Will 
these documents be updated by a set of users who infrequently use the program and 
may be unfamiliar with its features? If so, Word is a good choice.

Are you working on large documents with more than one or two sections or chapters, 
and/or complicated documents (with formatting other than straight text or simple 
tables, such as cross-references, numbered titles or lists, a standard page format to 
adhere to)? Does your project include multiple writers? Do you require a great deal of 
control over the elements of the document? If so, FrameMaker is a better choice.

Word has some nice features we wish FrameMaker had, such as sorting paragraphs, 
repeating the last command multiple times, and the ability to do a split screen (view 
two locations in the same document simultaneously). However, FrameMaker�s 
implementation far surpasses Word�s in functionality, completeness, and usability, 
particularly for creating books and manuals.

On What Platforms Will You Use the Document?

There are several platform issues. 

▼ FrameMaker is the same everywhere: Mac, PC, and UNIX.

▼ Word is the same nowhere. You can�t even move a Word file from one PC to 
another and expect things to stay the same. Also, Word does not run on UNIX. 

It is our experience that people who believe, for example, that they are using only PCs 
and will always use only PCs (or any other platform) almost always discover that 
there are compelling reasons for adding or changing platforms within a year or so.
3 Word 2000 vs. FrameMaker 6.0
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Do You Need to Convert the Document?

If the document already exists in one application and you must convert it, be aware of 
the pitfalls of converting to the other application.

FrameMaker ▼ Using FrameMaker�s built-in filters, you can save a document in a Word format (in 
one of several Mac or PC versions) or to RTF. 

▼ You can open RTF files and many Word files directly into FrameMaker. If the doc-
ument has lots of graphics and tables, however, it might not open. In these cases, 
save the Word file as RTF and try again. If it still fails, strip out the graphics, and 
possibly the tables, and FrameMaker might allow you to open the file.

▼ You can copy graphics or tables in FrameMaker and Paste (or Paste Special) them 
into Word with few problems.

▼ You can copy some graphics from Word into Frame, but many will become dis-
torted or will not paste in at all. In this case, you must save out the graphic as a 
separate file and import it into FrameMaker. 

Word ▼ You can save a document as a different version of Word (Mac or PC) and as RTF.

▼ You can open RTF and Word files in different versions.

▼ You can open HTML files and save as a a different type, such as Word or RTF.

Both ▼ You can copy graphics or tables in one application and Paste (or Paste Special) 
them into the other application with few problems.

▼ You can save a document as ASCII text and open the resulting file in any applica-
tion that opens ASCII. Converting to ASCII is your fallback position if opening the 
document directly fails (even without graphics and tables), RTF fails, or Copy/
Paste fails. Save the document as ASCII and open it in the other application. This 
process loses all of the formatting, but you must reformat the document anyway, 
so it�s really not that bad. Honest.

Of the two tools, it is easier to convert Word to FrameMaker than it is to convert 
FrameMaker to Word. Word has improved with the last couple of versions and has 
narrowed the gap.

Do You Need to Give the Document to a Print Vendor?

We have found that it is much easier to deliver the right thing to a print vendor when 
using FrameMaker, whether that be PostScript or something else. 

Word does not allow you to:

▼ Include crop marks or registration marks. 

▼ Specify whether you want fonts included in the PostScript file. 

▼ Create inverted images.

▼ Create color separation or spot colors. 

It is usually more difficult for print vendors to use the Word output. Some print 
vendors actually convert documents to something else before printing�it saves them 
time!
Word 2000 vs. FrameMaker 6.0 4
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Do You Need Online Versions?

You can create PDF and HTML versions of your documents using either Word or 
FrameMaker. The features and levels of control differ for each application.

Creating PDF Once you have installed Adobe Acrobat, you can create PDF versions of both Word 
and FrameMaker documents by printing to a PostScript file and then distilling that 
file. In addition, both applications have File menu commands that allow you to create 
a PDF directly.

▼ FrameMaker: The application includes the PDF file type in the Save As dialog box.

▼ Word: When you install Acrobat versions 4 and later, the installation process 
includes the option to install the PDFWriter feature. This feature adds a command 
and toolbar to the Word application.

Both applications allow you to specify bookmarks based on styles and TOC entries, 
convert cross-references to PDF links, and create structured bookmarks. 

In FrameMaker, you can add hypertext markers that convert to links in the PDF file. 
For example, hypertext markers that jump to a specific topic or jump to another 
document are converted to Acrobat links that perform the same function. 

The help implementation is different in the two applications. In FrameMaker, the 
application�s help file contains topics about creating PDF, adding bookmarks, and so 
on. In Word, the PDF help topics are supplied by Acrobat: you must click the Help 
button on the Acrobat PDFMaker dialog box to launch a PDF Help file. This is not a 
problem, but you need to know where to find the help file.

Creating
HTML

Both applications allow you to create hypertext links in your documents and convert 
them to HTML versions. The following paragraphs highlight the features of each 
application.

FrameMaker Features

▼ Use File>Save As to create web pages from an existing document. You can also 
launch WebWorks Standard from the File menu or use WebWorks Publisher Pro 
to convert the documents to HTML.

▼ Web pages contain named anchors for every paragraph (the default). Style sheet 
information is stored in a .css file.

▼ Supporting files generated as a result of the conversion are grouped in a subdirec-
tory.

▼ There is no page preview before conversion.

▼ Edit the FrameMaker document�s reference pages to adjust the format mapping 
and rerun the conversion.

Word Features

▼ Use File>Save As or File>Save as Web Page to create web pages from an existing 
file.

▼ Web pages contain style sheet information as well as the HTML formatting. When 
viewed in a browser, the web page displays many of the style elements that exist 
in the Word source document. 
5 Word 2000 vs. FrameMaker 6.0
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▼ Supporting files that are generated as a result of the conversion (graphics and 
XML files) are grouped in a subdirectory.

▼ Preview the web page before you convert the document.

▼ Edit the web page in Word and enhance the page by adding forms, frames, scroll-
ing text, and so on.

▼ Create new web pages using Word�s built-in templates.

What Level of Effort Can You Expect?

We tell our clients who are making this decision that Word documents require at least 
20% more effort than comparable FrameMaker documents. It has been our experience 
that you need extra time to fix things that magically go wrong and to work around 
things that Word doesn�t handle. (We think Word is full of gremlins.) We believe that 
you recoup the cost of FrameMaker within about 1 month. 
Word 2000 vs. FrameMaker 6.0 6
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Summary of Key Features 

Function FrameMaker 6 Word 2000

Book Functionality Designed for large books;1,000 page 
books OK; easy to create and maintain, 
including pagination

Not designed for large books; 100 pages in 
one file is OK; 1,000 pages in one file is 
unwieldy; master pages supposedly handle 
multiple file documents, but these introduce 
their own problems; automatic repagination of 
large files is irritating

Character Formats User-defined styles supported User-defined styles supported

Cross-References Cross-references easy to create and 
update

Cross-references can cause problems and are 
often unreliable; updating references can be 
slow

Graphics Drawing tool; inline editing; basic shapes 
and lines; imported and embedded 
graphics allowed; UNIX version contains 
built-in image capture; some color 
definition problems

Drawing tool; inline editing; large set of 
predefined autoshapes; imported and 
embedded graphics allowed

Page Layout Multiple page layouts supported; easy to 
combine different layouts in one document

Combining different layouts in the same 
document results in multiple sections that are 
cumbersome to maintain

Paragraph Formats Easy to apply, modify; can define number 
of lines in widow/orphan control; styles are 
not linked, so there is no domino effect 
when you update one style

Easy to apply; can modify them, but must 
beware of style inheritance; widow/orphan 
control is either on or off; pasted in text adds 
new formats to catalog

▼ Hyphenation Allows nonbreaking hyphens Allows nonbreaking hyphens

▼ Numbered and 
Bulleted Lists

Any combination of numbering in any 
format; easy to apply; any character can 
act as a bullet symbol

Supported, but sometimes difficult to make 
bullets and numbering stick; manually typing 
sometimes required

Portability PC, Mac, UNIX PC, comparable Mac version is 2001, no UNIX

Printing Supports registration marks, thumbnails, 
color separations

No registration marks, thumbnails, color 
separations

Revision 
Management

Conditional Text allows you to maintain 
different doc versions in same file; can 
compare documents

Versioning allows you to track changes; can 
review and accept changes individually; can 
compare documents

Sorting Supported for tables only Supported for tables, lists, paragraphs

Tables Reusable user-defined formats supported; 
two predefined formats included

Tables must be formatted individually so global 
updates are very time consuming; no user-
defined formats; several predefined formats 
included

Templates Comprehensive, robust, easy to use and 
modify; can import all format types 

Template files use .dot extension; must use 
template file to get page layouts; can merge 
only paragraph and character formats

Variables System-defined variables contain default 
format that can be modified; user-defined 
variables stored with document

Preset file properties are empty by default; 
custom document properties stored with the 
document 
7 Word 2000 vs. FrameMaker 6.0
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Detailed Application Comparison

Page Layout 

FrameMaker FrameMaker documents consist of one or more pages, each of which can have its own 
format. For each different page style, you define a master page. A master page is a 
stored format that you can apply automatically to pages (such as Left and Right) or 
manually to any page. Each master page contains its own margins, headers, and 
footers, allowing a document to have different layouts for right, left pages, and 
custom pages such as titles or chapter openers. You can specify both portrait and 
landscape master pages within the same document.

In addition, you can define different text flows allowing text to flow around graphics 
or other sections of text. You can use different text flows for sidebars or newsletters. 

Word Word documents usually have one (single-sided documents) or two (double-sided 
documents) page layouts. You can achieve additional page layouts by dividing the 
document into sections. Each section has its own page format (left and right layouts 
for double-sided documents) and can start anywhere on a page. Word does not have 
page styles. If nonsequential sections have the same format, you must redefine the 
page format for each section. You can have portrait and landscape pages within the 
same document by separating it into sections.

Margins, headers, and footers are associated with a section. You can define different 
headers and footers for right, left, and the first page of a section. Word has an option 
to duplicate the headers and footers from the previous section. However, if you do 
not want the headers and footers to be identical in each section, you must turn off 
�same as previous� to accomplish this. (It�s not as easy as it sounds!)

Word does not have an equivalent to FrameMaker�s named text flows. However, with 
Word 2000, you can create text boxes and link them to simulate a �flow� for 
documents such as newsletters.

Feature FrameMaker 6 Word 2000

Page layout type Page styles
(master pages)

Section breaks

Text flows Named flows Linked text boxes

Margins Stored in page format By section

Different headers/footers for 
different pages

✔ Stored with page 
style

By section; right, left, or 
first page only

Page orientation
▼ Portrait
▼ Landscape
▼ Intermingle in one document

✔ 
✔ 
✔ 

✔ 
✔ 

✔ Separate sections
8 Word 2000 vs. FrameMaker 6.0
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Paragraph Formats

Feature FrameMaker 6 Word 2000

Define named formats ✔ ✔ 

Format inheritance no ✔ 

Associate line with format ✔ Above and below 
only

✔ 

Associate image with format ✔ Above and below 
only

✔ Bullets only

Text placement
▼ Body text
▼ Run-in Heads
▼ Side Heads
▼ Across all columns

✔ 
✔ 
✔ 

✔ 
no
no

Starting placement
▼ Top of next column
▼ Top of new page
▼ Top of left page
▼ Top of right page
▼ In margin area

✔ 
✔ 
✔ 
✔ 
no

✔ (if section)
✔ 
no
no
✔ 

Keep together Keep with next and/or 
previous

Keep with next only

Widow/orphan control
▼ Custom settings

✔ 
✔ 

✔ 
no

Indents: Left, right, hanging, first 
line

✔ ✔ 

Line spacing
▼ Single, 1.5, double
▼ Fixed (�Exactly�)
▼ �At Least�
▼ �Multiple�

✔ 
✔ 

Default, not separate
no

✔ 
✔ 
✔ 
✔ 

Space above and below 
paragraph

✔ ✔ 

Automatic paragraph labeling
▼ Numbers or bullets
▼ Graphics
▼ Text, such as �Note�
▼ Label at beginning
▼ Label at end
▼ Dropped capital letter

✔ 
no
✔ 
✔ 
✔ 

manual

✔ 
✔ 
no
✔ 
no

menu command

Inline format overrides ✔ ✔ 
9 Word 2000 vs. FrameMaker 6.0
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FrameMaker In FrameMaker, you create named paragraph formats that are stored with the file. 
Format names are also known as tags. You add, update, and override paragraph 
formats in the Paragraph Designer dialog box. The Paragraph Designer contains tabs 
that represent each of the format�s characteristics, including indents, line spacing, 
font, pagination, and tab stops. You can also override a paragraph format using the 
tool bar and formatting bars.

Unlike Word, FrameMaker formats are always independent of each other�there is no 
concept of inheritance. Thus, you cannot change one format and inadvertently affect 
15 other formats (as with Word�s �Automatically update� style setting). You can 
identify which paragraph tag follows the current one when you press Return.

There are five types of paragraphs: in-column text, run-in head, side head, across all 
columns, and across all columns and side heads. By default, paragraphs can start 
anywhere on a page. You can specify that a paragraph start at the top of a column or 
at the top of new, left, or right page. You can also indicate that the current paragraph 
should be kept together with the previous and/or next paragraph.

Other attributes:

▼ Specify autonumbers or bullets that appear at the beginning or end of a paragraph; 
use a different character style for the numbers or bullets. 

▼ Include text at the beginning or end of a paragraph, such as for a Note or Caution 
paragraph. Numbering at the end of a paragraph is useful for equations.

▼ Associate a graphic (including lines) with a paragraph, but only above or below 
the paragraph. Using the Reference pages, you can add save left or right standard 
graphics for ease in cutting and pasting as needed. 

▼ Include widow and orphan control; indicate how many lines to include.

FrameMaker associates a paragraph format with the beginning of the paragraph. 
When you merge two paragraphs, the new paragraph takes on the first paragraph�s 
format.

Word In Word, you create named paragraph styles that are stored with the file and, 
potentially, with the template associated with the file.

You add and update paragraph styles in the Style dialog box. From the Style dialog 
box, you access the New Style or Modify Style dialog box. From the New Style or 
Modify Style dialog boxes, you select an option form the Format drop down list to 
access dialog boxes for each of the format�s characteristics, including font, paragraph, 
tabs, borders, language, frame, and numbering. You override formats through the 
dialog boxes accessed through the Format menu (Font, Paragraph, etc.) or through the 
tool bar. Note that overriding a format for a style that is set to �Automatically update� 
will change every paragraph set to this style.

Styles can be independent or inherit attributes from a base style (the default). Any 
time you change the base style, Word also changes all styles that originate from that 
base style. This can be useful when creating a template and annoying when you want 
to change only one style.

You can use any name for a style. However, it is easier to use Word�s built-in style 
names when you create outlines. These built-in styles already contain the 
characteristics you need for outline levels. You can create your own outline styles, but 
Word 2000 vs. FrameMaker 6.0 10
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you must assign an outline level to each style and make sure that you inherit 
attributes from the correct base style.

The default paragraph type is in-column text. However, Word allows you to place 
text in the margin area by setting a negative left or right indent. Word does not have 
the concept of side heads or run-in heads. You can simulate side heads using text 
boxes, but you must adjust the position of every text box based on the length of the 
heading text. 

By default, paragraphs can start anywhere on a page. You can specify to start a 
paragraph at the top of a new page; no other options are available. You can also 
specify to keep the current paragraph with the next paragraph or to keep the entire 
paragraph together; you cannot specify �keep with previous.� 

Additional attributes you can specify in a style:

▼ Specify autonumbers or bullets to appear at the beginning of a paragraph; apply a 
different character style to the numbers or bullets. 

▼ Associate a graphic as a bullet; no other way to associate a graphic with a style.

▼ Apply borders to the left, right, top, and bottom of a paragraph.

▼ Include widow and orphan control, but cannot indicate how many lines to 
include.

Attributes you must apply to individual paragraphs, overriding the style:

▼ Insert graphics or icons, such as notes and cautions; standard graphics must be 
stored in a different file.

▼ Create Drop Capital Letter(s) at beginning of paragraph.

▼ Apply border to first, last or all paragraphs in a group of identical styles.

Word associates a style with the paragraph marker. When you merge two 
paragraphs, the new paragraph takes on the second paragraph�s format. This can be 
very annoying.

When you paste in formatted text from another document, Word does the following:

▼ If the pasted text has a style that is listed in the document�s style catalog, that text 
is automatically reformatted. 

▼ If the pasted text has a style that does not exist in the document�s style catalog, that 
style is added to the catalog. 

To can avoid these automatic changes by pasting in the text using the Paste Special 
command and selecting �Unformatted Text.�
11 Word 2000 vs. FrameMaker 6.0
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Tab Stops

FrameMaker FrameMaker tab stops are absolute. FrameMaker Help describes relative and absolute 
tab stops as:

�With relative tab stops, each time you press Tab, the insertion point moves to 
the next available tab stop. With absolute tab stops, the nth tab on a line moves 
the insertion point to the nth stop. If that tab stop is to the left of the insertion 
point, the insertion point does not move.�

FrameMaker has four types of tab stops: right, left, center, and decimal. You can set 
tab stops for any paragraph style in the Paragraph Designer. You can also set tab 
stops for the current paragraph in the Paragraph Designer or by clicking in the page 
ruler. Unlike Word, FrameMaker does not insert default tab stops.

FrameMaker contains the following options for tab stops:

▼ Decimal tab stops: use the predefined decimal point character or specify a different 
character.

▼ Tab leaders for all tab stops: in addition to four default settings, you can specify 
any character as a custom leader.

▼ Multiple tab stops at regular intervals: specify an interval between tab stops.

Word Tab stops in Word are relative. This means that the insertion point moves to the next 
available tab stop each time you type a tab character. While you can specify a tab stop 
position for a paragraph style, it is not absolute. The tab stop moves to the next 
available default tab position if the text exceeds the available space.

Word has five types of tab stops: right, left, center, decimal, and bar. You can set tab 
stops for a paragraph style through the Style dialog box. You can also set tab stops for 
the current paragraph in the Format>Tabs dialog box or by clicking in the page ruler. 

Word inserts default tab stops every 0.5 inches. You can change the default tab stop 
measurement in the Tabs dialog box, but be aware that this affects all paragraphs. If 
you define a tab stop between two default tab stops, Word removes all default tabs in 
front of your tab stop and leaves the others as is.

The bar tab stop inserts a bar at the tab stop position; the bar appears as soon as you 
set the tab stop type to bar. It does not affect the text flow; it appears in the middle of 
any text that crosses the tab stop position. 

Word limits tab leaders to four preset options.

Feature FrameMaker 6 Word 2000

Left, right, center tab ✔ ✔ 

Decimal tab
▼ Predefined
▼ Custom

✔ 
✔ 

✔ 
no

Bar tab no ✔ 

Tab leaders
▼ Predefined
▼ Custom

✔ 
✔ 

✔ 
no
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Numbered and Bulleted Lists

FrameMaker The autonumbering feature allows you to create numbered, bulleted, and tagged 
paragraphs, such as �Note.� To create an autonumbered paragraph, you define its 
parameters in the Numbering tab of the Paragraph Designer. These parameters can 
include bullets, numbering sequences, text, and formatting characters, such as periods 
and tabs. 

You can associate autonumbering with a paragraph style. FrameMaker does not 
contain separate menu commands or tool bar buttons to apply these features. You can 
have autonumbering appear at either the start or end of a paragraph.

Styles that use numbered sequences can have independent numbering sequences or 
can share numbering sequences. You can number anything, including headings, table 
titles, or steps. Numbering can continue throughout files in a book or start over in 
each file. To restart the numbering for a list, it is standard practice to define a 
paragraph format that restarts the list at one; so for each numbered list type, you 
define two formats: one to start the list and one for all subsequent items in the list.

Once you have defined and applied a numbering style, FrameMaker automatically 
renumbers the list items whenever you add, delete, or rearrange steps. You can 
embed and remove any paragraph styles between list items without affecting the 
numbering scheme. 

FrameMaker includes the <$chapnum> and <$volnum> variables that allow you to 
easily include chapter and volume numbers in paragraph styles. This is useful when 
you need to include the chapter number as part of a table of figure number. 
FrameMaker provides a set of building blocks, including these variables, that allow 
you to specify a complex numbering scheme, if necessary.

You can set the character style for the autonumbering characters to be different from 
the paragraph text by selecting a character tag name in the Character Format list in the 
Numbering tab. By default, FrameMaker uses the paragraph�s character format. 

Feature FrameMaker 6 Word 2000

Automatic numbering ✔ ✔ 

Apply numbering to
▼ Headings
▼ Table titles
▼ Figure titles
▼ Lists
▼ Any text

✔ 
✔ 
✔ 
✔ 
✔ 

✔ 
no
no
✔ 

✔ sort of

Bullets
▼ Standard bullet
▼ Any character as bullet
▼ Graphic as bullet

✔ 
✔ 
no

✔ 
✔ 
✔ 

Associate with paragraph format ✔ no
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Word In Word you can create numbered, bulleted (bullet characters or images), and tagged 
formats. You set autonumbering using one of the following:

▼ Format>Bullets and Numbering command 

▼ Bullets or Numbering buttons in the Formatting toolbar

▼ Format>Style>Modify>Format>Numbering command

To create the format, you select the type (Bulleted, Numbered, Outline Numbered) 
and style of numbering. For each type, Word contains eight preset styles including 
�None.� You can customize any style (except �None�) to change the numbering style, 
formatting characters, font, and spacing. You can associate a numbering style with a 
paragraph style. 

Once you have defined and applied a numbering style, Word automatically 
renumbers the list items whenever you add, delete, or rearrange steps. Unlike 
previous versions, Word 2000 allows you to embed and remove any paragraph styles 
between list items without affecting the numbering scheme. 

To restart the numbering for a list, you must select the �Restart Numbering� option in 
the Bullets and Numbering dialog box (Format>Bullets and Numbering command). 

In addition to bullet characters, you can use images for bullets, called picture bullets. 
You can use the bullet images supplied by Microsoft or your own images. The outline 
numbering feature is also very useful.

Trying to add bullets or numbering to styles can be frustrating; users frequently resort 
to overriding styles to format documents, playing havoc with document consistency. 
For example, the �Restart numbering� option does not always work, so you must find 
an alternate way to number the list correctly.

Hyphenation

FrameMaker FrameMaker automatically hyphenates and removes hyphenation as you type. You 
cannot turn off hyphenation at a document level. You can turn off hyphenation for 
particular paragraph styles. For example, you can suppress hyphenation for all 
heading and code paragraph styles.

In addition, you can specify the hyphenation for an individual word:

▼ Insert a �discretionary� (optional) hyphen

▼ Insert a nonbreaking hyphen

▼ Change the hyphenation of a word by adding it to the dictionary

Feature FrameMaker 6 Word 2000

Automated ✔ ✔ 

Discretionary (optional) hyphens ✔ ✔ 

Nonbreaking hyphens
▼ Individual word
▼ Dictionary

✔ 
✔ 

✔ 
no

Suppress hyphenation for a word ✔ no

Configure hyphenation ✔ ✔ 
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▼ Suppress the hyphenation of a word by adding it to the dictionary

For paragraph styles that include hyphenation, you can configure hyphenation by 
specifying:

▼ Maximum number of consecutive lines that can end with a hyphen

▼ Minimum length of a hyphenated word

▼ Minimum number of letters that can precede and follow a hyphen

Word Word contains manual and automatic hyphenation. In automatic hyphenation, Word 
inserts and removes hyphenation as you type. In manual hyphenation, Word searches 
the text for words to hyphenate, asks for your confirmation, and inserts optional 
hyphens in the text. In manual mode, Word does not rehyphenate the document 
unless you go through the manual hyphenation process again.

You can suppress hyphenation for a paragraph style; there are no other options at a 
style level.

In addition, you can specify the hyphenation for an individual word:

▼ Insert an optional (discretionary) hyphen

▼ Insert a nonbreaking hyphen

You can set parameters that apply to document-wide hyphenation:

▼ Maximum consecutive lines that contain hyphenation

▼ Distance between the end of the last word and the margin.

Character Formats

Feature FrameMaker 6 Word 2000

Define named formats ✔ ✔ 

Case 
▼ All caps
▼ All lowercase
▼ Small caps
▼ Title case

✔ 
✔ 
✔ 
✔ 

✔ 
no
✔ 
✔ 

Superscript and subscript
▼ Superscript
▼ Subscript
▼ Adjust vertical position and 

size

✔ 
✔ 

✔ document-specific

✔ 
✔ 

✔ format specific

Spacing
▼ Spread (spacing in Word)
▼ Stretch (scale in Word)
▼ Kerning

✔ 
✔ 
✔ 

✔ 
✔ 
✔ 
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Soapbox Character formats are one of the under-used features of both FrameMaker and Word. 
Many writers use font overrides to get the look they need, introducing all sorts of 
inconsistencies and making the document a production nightmare.

By properly using character formats, writers can prevent font, weight, and other 
inconsistencies between documents in the same suite. Intuitively named formats 
allow writers to select the correct format for their documents. For example, by 
creating a format named �Emphasis� and setting it to italic, writers don�t have to 
remember whether emphasized words are bold or italic.

Consistently using character formats instead of overrides makes document 
maintenance easier. For example, if you must change emphasized words from italic to 
bold, one change to the character format can update all text that uses that format. It is 
also easy to search for text that uses a particular character format.

FrameMaker You create character formats using the Character Designer. The formats are stored in 
the document; a list of the formats appears in the Character Catalog. In the status bar 
area, FrameMaker displays the names of current paragraph format and character 
format (if any) for selected text; �f:� identifies the character tag.

FrameMaker supports standard point size, weight, angle, and color features. See the 
table above for a list of other included features. While FrameMaker allows you to 
adjust the position and size of superscript, subscript, and small caps, the settings are 
only at a document level. All other features can be applied on an override basis or can 
be stored in a character format.

You can apply character formats using the character catalog, keyboard shortcuts, or 
through the Character Designer.

Text effects
▼ Underline
▼ Underline in a different color
▼ Overline
▼ Strikethrough, single
▼ Strikethrough, double

✔ (3 types)
no
✔ 
✔ 
no

✔ (16 types)
✔ 
✔ 
✔ 
✔ 

Other text effects
▼ Change bar
▼ Shadow
▼ Emboss
▼ Engrave
▼ Hidden
▼ Outline

✔ 
no
no
no
no
no

no
✔ 
✔ 
✔ 
✔ 
✔ 

Language selection ✔ ✔ 

Borders and shading no ✔ 

Text animation no ✔ 

Feature FrameMaker 6 Word 2000
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Word Character styles were added in later versions of Word. They appear in same list as 
paragraph styles, which can be confusing.

Word displays either the paragraph style or character style names for selected text. If 
you applied a character style to an entire paragraph, there is no easy way to find out 
what the paragraph style is.

Word supports the standard point size, weight, angle, and color features. Word 
contains many more text effects than FrameMaker. See the table above for a list of 
other included features. Word allows you to adjust the position and size of characters 
at a style level. Using this feature you can define your own superscript and subscript 
formats that use parameters other than Word�s default formats. All features can be 
applied on an override basis or can be stored in a character format.

Tables

Feature FrameMaker 6 Word 2000

Variable cell sizes Only by straddling cells ✔ 

Straddling cells
▼ Horizontally
▼ Vertically

✔ 
✔ 

✔ 
✔ 

Rotated cell contents ✔ ✔ 

Ruling (borders) ✔ ✔ 

Shading ✔ ✔ 

Specify starting position
▼ Top of any page
▼ Top of left page
▼ Top of right page
▼ Top of column
▼ Float

✔ 
✔ 
✔ 
✔ 
✔ 

Top of page or column 
control only through 

page or section breaks

no

Repeat column headings 
▼ Automatic repeat

✔ 
✔ 

✔ 
no

Multiple heading rows ✔ ✔ 

Footing rows ✔ no

Table titles (caption)
▼ Automatic creation
▼ Automatic table title repeat

✔ 
✔ 

✔ 
no

Automatic �continued� indicator ✔ no

Widow and orphan control ✔ no

Nested tables ✔ ✔ 

Formats
▼ Predefined
▼ Save custom formats

✔ (2)
✔ 

✔ (42)
no
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FrameMaker By default, all rows in a table are the same size and all cells in a column are the same 
size. You can adjust the height of individual rows and adjust the width of individual 
columns. Unlike Word, you cannot adjust the height or width of an individual cell. 
However, you can use straddling, either vertically or horizontally, to create cells that 
appear to be different sizes.

You can automatically repeat cell headings on each page and can include multiple 
rows in heading. �Automatic� means that any text you enter in a designated 
�heading� row will automatically display on an subsequent pages on which the table 
continues. You can have one or more heading and footing rows.

If you have a table title, it automatically repeats on if the table spans more than one 
page. You can optionally include a TableContinued variable that displays only in 
continuation pages.

You specify a table�s parameters in the Table Designer; there are separate tabs for 
basic properties, ruling, and shading.

▼ Basic: Starting position, indents, spacing, alignment, cell numbering order, cell 
margins, include table title, and number of orphan rows

▼ Ruling: Column ruling, row ruling, heading and footing ruling, outside ruling; can 
specify different ruling for select columns and rows

▼ Shading: Heading and footing shading, body cell shading; can specify different 
shading for selected rows

FrameMaker contains two predefined table formats. You can save custom formats in 
the Table format catalog that includes all the information defined in the Table 
Designer. For each stored format FrameMaker remembers the number of rows and 
columns that were present at save time, as well as the paragraph formats in the table 
cells. 

You can use FrameMaker�s Table menu commands to modify or override the table 
format.

▼ Row Format: Row height minimum and maximum, starting position for the row, 
keep with next or previous

▼ Custom Ruling & Shading: Override the ruling and shading for any cell, row, or 
column

▼ Resize Columns: Specify the width of the column by percentage, unit of measure-
ment, size of contents, or to match another column

You can set specific cell margins for a paragraph format on the Table Cell tab of the 
Paragraph Designer.

Word Within a table, rows and columns can have different widths and heights. You can 
adjust the height or width of an individual cell and you can merge two or more cells 
either vertically or horizontally.

You can repeat cell headings on each page and can include multiple rows in the 
heading. You must highlight the heading rows and select the Table>Heading Rows 
Repeat command to start the process. Word then automatically displays the heading 
row(s) on an subsequent pages on which the table continues. Word does not have 
footing rows.
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Table captions (titles) are separate from the table and do not repeat on subsequent 
pages. The table caption is simply another paragraph. If you delete a table, the table 
caption remains; you must delete it separately. There is no automatic way to indicate 
that the table continues from the previous page.

You can specify a table�s parameters in the Table Properties dialog box. There are 
separate tabs for table, row, column, and cell properties.

▼ Table: Preferred width, alignment, indents, text wrap and positioning, borders and 
shading, default cell margins

▼ Row: Height, break/don�t break across pages, repeat as header

▼ Column: Width

▼ Cell: Width, vertical alignment, cell margins that override table-level margins, text 
wrap within the cell

Word does not include an orphan row setting. To manipulate the placement of a table 
or to keep rows together, you can change some settings in the paragraph formats 
involved using the Format>Paragraph menu command. Note that these format 
overrides do not work consistently, so beware.

To keep two rows together, make sure that the text in the first row before it is set to 
�Keep with Next� and that this setting is turned off for the text in the second row. 
Similarly, if you want a row to break to the next page, make sure that the text in the 
previous row is not set to �Keep with Next.�

To move a table to the top of a page, you can do one of the following:

▼ Insert a page break before the table.

▼ Place the cursor in the first cell of the table (on the upper left). Using the For-
mat>Paragraph command, set the paragraph to �Page break before.�

Word contains 42 predefined table formats. You can create a table using one of these 
formats using the AutoFormat button in the Insert Table dialog box. You can apply a 
format to an existing table using the Table AutoFormat command. Word does not 
allow you to store custom formats.

You can override row, column, and cell formats using any of Word�s table tools. 
However, you cannot store any changes to the predefined table formats. You must 
update each table in a document individually. 
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Graphics

FrameMaker You create and edit FrameMaker graphics in the same window as the document. The 
built-in drawing tool allows you to create moderately interesting graphics. The 
application has some clip art that you can copy into your documents, including 
symbols and flowchart items. If you need to create complex graphics, you are better 
off using a �real� graphics tool to create the graphics and then import them into 
FrameMaker. 

One of FrameMaker�s strengths is the ability to import a wide variety of graphic types 
using filters. The above table only lists a few of the graphic types; a complete list of 
the graphic import filters is in FrameMaker�s online User Manual, Using Filters. You 
can embed a graphic in the document using Import by Copy or reference it using 
Import by Reference. Import by Copy graphics increase the size of the document; 
Import by Reference graphics do not. 

Feature FrameMaker 6 Word 2000

Drawing tool shapes
▼ Graphics editing
▼ Circles 
▼ Ovals
▼ Rectangles
▼ Polygons
▼ Lines and arrows
▼ Curves
▼ Freeform
▼ Callout boxes and lines
▼ Other predefined shapes

Inline
✔ 
✔ 
✔ 

✔ (arcs)
✔ 
✔ 
✔ 

User must create 
no

Inline
✔ 

✔ (autoshape)
✔ 

✔ (autoshape)
✔ 

✔ (autoshape)
✔ 

✔ (autoshape)
✔ in autoshapes

Drawing object actions
▼ Group and ungroup
▼ Scale
▼ Align
▼ Distribute
▼ Snap
▼ Rotate
▼ Flip vertically and 

horizontally
▼ Join

✔ 
✔ 
✔ 
✔ 
✔ 
✔ 
✔ 
✔ 

✔ 
✔ 
✔ 

✔ limited
✔ 
✔ 
✔ 
no

Graphic file types
▼ GIF
▼ JPG
▼ BMP
▼ EMF
▼ EPS
▼ TIF

✔ 
✔ 
✔ 
✔ 
✔ 
✔ 

✔ 
✔ 
✔ 
✔ 
✔ 
✔ 

Imported graphics
▼ Embedded
▼ By reference

✔ 
✔ (importing)

✔ 
✔ (linking)

Graphics placement
▼ In text flow
▼ Outside of text flow

✔ 
✔ 

✔ 
✔ 
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Creating or placing imported graphics into an anchored frame allows the graphics to 
move with the text. If you draw or import a graphic directly to a page and not in an 
anchored frame, the graphic remains on that page and does not move when you add 
or remove text. This is not a bad thing if that�s what you intend.

You can set the properties of a graphic so that text flows above and below it, or 
around it. You can set the properties of the anchored frame to place it in-line with the 
text, at the top or bottom of a page, or running into the paragraph.

One of the interesting features of the drawing tool is the ability to join two objects end 
to end to create a new one.

Word You can create and edit Word drawings in the same window as the document. In 
addition to standard shapes of circles, rectangles, lines, and arrows, Word contains 
several sets of autoshapes:

▼ 4 additional line types

▼ 30 additional basic shapes, including 3-dimensional boxes and braces

▼ 28 arrow boxes

▼ 28 flow chart shapes

▼ 16 star and banner shapes

▼ 20 predefined callout types

In addition to the autoshapes, Word supplies a large set of clip art that you can choose 
to install. As with FrameMaker, if you have complex graphics to create, it is probably 
better to create them in a real graphics program and link them to the Word document.

Word allows you to wrap text around the graphics in a variety of ways. One of the 
most annoying things in Word is the fact that graphics do not always behave the way 
you want them to: if you want them to move with the text, they don�t; if you want 
them to stay in one place, they jump to the next page. Part of the problem is the result 
of how you insert the image; the other part is Word�s idiosyncrasies:

▼ If you insert the image directly into the document, the image tends move when 
you add or remove text until Word thinks it will not longer fit on the page. The 
image will then jump to the next (or previous) page, often skipping past the text.

▼ If you insert the image into a text box, the image may or may not move with the 
text depending on the type of wrapping you selected and whether you add or 
delete text.
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Book Functionality

FrameMaker The book file is a separate FrameMaker entity that allows you to take multiple 
documents and treat them as one unit. You can add or remove documents in a book, 
specify the order in which they appear, set the page numbering, and set chapter or 
volume numbering. When you open a book file, FrameMaker displays a book 
window that lists the documents contained in this book; it does not display the 
contents of each document. You can use a document in more than one book, if 
appropriate. 

You use the book file to navigate between the documents in the book. For example, 
you can open a document by double-clicking its name in the book window. You can 
also perform certain operations across an entire book, including:

▼ Import format definitions and page layouts to one or more files 

▼ Search and replace text and variables

▼ Check spelling, punctuation, and extra spaces

▼ Change conditional text settings

▼ Update cross-references

When you invoke a book-wide command, FrameMaker opens the document, applies 
the command, saves, and closes the document. If the document is already open, 
FrameMaker applies the command, but does not save and close the document. Unless 
the document is already open, the operation takes place behind the scenes. At the 
bottom of the book window, FrameMaker displays status information while it is 
working. When the operation is completed, the status area is empty if successful. If 
not successful, FrameMaker displays a message indicating that error messages were 
written to the log file and displays the error log file. The error log contains some 
problems, including hyperlinks to unresolved cross-references in each chapter.

You can easily reorder the documents in the book file by dragging and dropping the 
file names in the book window. You can change the chapter numbers and starting 
page numbers in the book window without opening the individual documents. You 
can rename files in the book and tell the book to update all references to that file 
name. 

Table of contents (TOC), indexes (IX), and other lists are separate documents in a 
book; they are not embedded in an existing file. The TOC and IX are generated files 
and can be updated during the Update Book process. See the �Table of Contents and 
Other Lists� and �Indexes� sections that follow for more information.

You can print an entire book from within the book window without opening any of 
the book�s documents. You can also select one or more documents to print from the 
book window without opening the individual documents. In addition, you can use 
the book�s menu commands to generate either a PDF or HTML version of the book or 
selected files within the book.

Word A master document allows you to combine multiple documents (subdocuments) into one 
document. You can add or remove subdocuments and specify the order in which they 
appear. When you open a master document, Word displays a document window and 
lists each subdocument as a hypertext link. You normally work on a master document 
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in the Outline view. You can display the content of a subdocument in the master 
document window by clicking the Expand Subdocuments button.

You can use the master document to view the content or to navigate to the individual 
subdocument. If you have expanded the subdocuments in the master document, you 
can perform certain operations across all subdocuments including:

▼ Search and replace text

▼ Spell check

▼ Merge styles

When you make a change, it first appears in the master document�s content display. 
When you save the changes, Word writes them to the individual subdocuments. 

You can change the order of the documents by dragging and dropping the 
subdocument name to the preferred position. However, it is more accurate to reorder 
subdocuments when they are not expanded; it is too easy to move the subdocument 
to the wrong location when the content is displayed. 

You add table of contents and indexes to the master document where they become 
part of the document. You can also create separate subdocuments for the TOC and 
Index, if desired. See the �Table of Contents and Other Lists� and �Indexes� sections 
that follow for more information.

You can print all or part of the content in a master document by expanding or 
collapsing the headings to display the content to print. You can also print individual 
subdocuments by opening them and printing from the subdocument window. You 
can create a PDF or HTML version of subdocuments through the master document.

Table of Contents and Other Lists

FrameMaker Table of contents (TOC) is a generated file in FrameMaker. You can create a TOC for 
an individual file or for a book. You identify the paragraph formats that FrameMaker 
uses during TOC generation. You can include any paragraph format in a TOC. 

Each time you generate a TOC, FrameMaker discards the previous contents and 
extracts the current contents for the associated paragraph formats. FrameMaker 
creates a separate file for the TOC. While you cannot generate a TOC inside an 
individual document, you can import the text by reference and update that text inset 
each time you regenerate.

FrameMaker saves the list of selected paragraph formats and automatically uses the 
list each time you generate a book. For individual documents, FrameMaker displays a 
dialog box that lists your previous selections and the list of potential formats you can 
include in the TOC. You can change your selections and generate the TOC from this 

Feature FrameMaker 6 Word 2000

Identify paragraph formats to use ✔ ✔ 

Navigate from entry to source ✔ ✔ 

Generate TOC in same file no ✔ 

Generate other list types ✔ ✔ 
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dialog box. Optionally, you can create hypertext links for each entry, allowing you to 
navigate from the index entry to the source text.

Special reference pages control what FrameMaker extracts and the general layout of 
the content. For example, if you want a tab to appear between heading text and its 
associated page number, you must indicate that in the reference page. If you want the 
chapter number to appear before the chapter title, you must list that in the reference 
page. FrameMaker takes the font, spacing, and position information from TOC 
paragraph formats that correspond to the paragraph format name (for example, 
1HeadingTOC corresponds to the 1Heading paragraph format). 

In addition to the TOC, you can generate the following lists:

▼ Figures

▼ Tables

▼ Paragraphs, in page order or alphabetical order

▼ Markers, in page order or alphabetical order

▼ References, including imported graphics and text insets

Word You can generate a TOC for an individual document, a group of documents, or a 
master document. You can generate a TOC in any part of a document.

You select the TOC layout in the Index and Tables dialog box. Word provides six 
standard layouts or you can choose �From Template� and adjust the template�s styles 
to get the look you want. You also identify which paragraph styles to include, 
specifying the TOC level for each selection. Word uses the TOC level to determine 
which TOC paragraph style to use (TOC1, TOC2, and so on). You can also use Word�s 
TC field code to flag entries to be used in a table of contents.

You can generate a TOC in any part of a document. Once you have inserted a TOC, 
you can easily update it by highlighting the TOC and pressing F9. 

The TOC�s appearance is controlled by your selections in the Index and Tables dialog 
box, any TC field codes you added, and the TOC paragraph styles. You can make 
further display modifications using the options in the TOC field code. 

In addition to TOC, you can generate the following lists:

▼ Figures

▼ Tables

▼ Equations

▼ Authorities
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Indexes

FrameMaker The Index (IX) is a generated file in FrameMaker. You can create an index for an 
individual file or for a book. You identify index entries by inserting a marker in the 
text. FrameMaker supplies the Index marker as the default marker to use. You can 
also add your own markers to handle special index entries. 

Each time you generate an index, FrameMaker discards the previous entries and 
extracts the current entries for the identified markers. As with the TOC, FrameMaker 
creates a separate file for the index. While you cannot directly insert an index in an 
individual document, you can import the index by reference as a text inset and update 
that text inset each time you regenerate the book. 

FrameMaker saves the list of selected markers and automatically uses this list each 
time you generate the book. For individual documents, FrameMaker displays a dialog 
box that lists your previous selections and the list of potential markers you can use for 
the index. You can change your selections and generate the index from this dialog 
box. Optionally, you can create hypertext links for each entry, allowing you to 
navigate from the index entry to the source text.

FrameMaker uses special index paragraph formats to format the entries in the index. 
A special reference page controls the sort order; page separators for multiple pages 
and page ranges; headers to use for alphabetic, numeric, and other entries; and the 
page number format for each entry. Page number formats do not account for page 
number hyphenation variants within the same book such as, e.g., page vii in preface 
and 2-1 in chapter 2. To include these markers in the index, you must use separate 
formats on the Reference page for these variants, set up separate marker types in the 
affected chapters, and set the index to pick up these additional marker types.

The contents of the Index marker is either text that you selected before inserting the 
marker or text that you type in the Marker dialog box. You can enter multiple index 
entries in a single marker, up to 255 characters. 

You can embed any character formats�tags or whatever�in the Index marker for 
any portions of the entry by typing the formatting commands as part of the entry. You 
can also specify an individual sort order for each entry that�s different from text 

Feature FrameMaker 6 Word 2000

Index entry type Index markers Field codes

Embed character formats
▼ Bold and italic
▼ Other formatting

✔ 
Character formats

✔ 
Character shortcuts

Specify different sort order ✔ ✔ 

Group separators
▼ Automatic
▼ Custom

✔ 
✔ 

✔ 
✔ 

Include page ranges ✔ ✔ 

Navigate from entry to source ✔ ✔ 

Generate in same file no ✔ 

Generate other list types ✔ ✔ 
25 Word 2000 vs. FrameMaker 6.0
June 16, 2004 Copyright © 1990-2004 Expert Support Inc.  All rights reserved.



Version 2.0
content. For example, you can sort �*� under �A� for �asterisk� or sort �101 
Dalmatians� under �O� for �One.� Also, you can specify that a reference such as �See 
also� is listed at the beginning or end of the index entry list for a particular topic.

You can include index entries that contain page ranges by placing a marker at the 
beginning of the page range and one at the end of the page range.

You can use FrameMaker�s Find/Change feature to search for markers or marker text. 
You can also cut or copy markers and paste them in a new location. 

In addition to a standard index, you can generate the following indexes:

▼ Authors

▼ Subjects

▼ Markers

▼ References, including imported graphics and text insets

Word You can generate an index for an individual document, a group of documents, or a 
master document. You can generate an index in any part of a document.

You select the index layout in the Index and Tables dialog box. Word provides six 
standard layouts or you can choose �From Template� and adjust the template�s styles 
to get the look you want. In addition to the layout, you can specify the number of 
columns in which to display the index.

You identify index entries by marking an entry. Marking an entry inserts an XE field 
code that contains the text of the entry. You can mark an entry by using either the 
Mark Index Entry dialog box or by inserting an XE field code using the Field dialog 
box.

Note: In the Word 2000 Mark Entry dialog box, the Main entry and Subentry text boxes 
display only 17 characters at a time; on some platforms, the text straddles the 
baseline, making it appear sunken. You cannot see the entire entry. We recommend 
using the field code instead of the dialog box because it�s easier to enter or edit the 
text.

The contents of the entry is either text that you selected before marking the entry or 
text that you type in the dialog box or XE field code. You can only have one index 
entry per XE field code, If you need multiple entries, you must enter multiple index 
field codes. One nice feature is that you can select the �Mark All �option to pick up all 
matching text in the document and create index entries for each occurrence.

You can embed character formatting in an entry using character-formatting shortcuts. 
You can also specify bold or italic page numbers, in the index entry box. You can 
perform other formatting in the generated index, but it is lost every time the index is 
generated.

Index entries that contain page ranges require that you select the text in the range, 
insert a bookmark and then insert the index field code and the end of the range.

When you display Word�s field codes, you can view the index entries easily within 
the text and perform global search and replaces. One disadvantage is that you can 
inadvertently trash your index entry by typing over part of it.
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The index�s appearance is controlled by the XE field code options, your selections in 
the Index and Tables dialog box, and the Index paragraph styles. You can make 
further display modifications using the options in the Index field code.

Cross-References

FrameMaker You can insert cross-references to any paragraph in a FrameMaker document. 
FrameMaker uses Cross-Ref markers to keep track of the source text. You can also 
insert cross-references to a specific spot in a paragraph. 

Cross-references are �internal� (the same file) or �external� (in another file). 
FrameMaker does not limit external cross-references to within a book; you can cross-
reference to any other FrameMaker file as long as you open it first. 

Cross-references display all or part of the source text, as defined by the cross-
reference format. FrameMaker contains a default set of cross-reference formats. You 
can also create your own cross-reference formats using a combination of building 
blocks, special characters, and character formats.

During the book building process, you can choose to update cross-references or all 
book files. You can also update cross-references in an individual file at any time. 

Word You can insert cross-references to eight types of text:

Word uses REF field codes to keep track of the source text.

You can insert cross-references to text within a file or to another file in the same 
master document. You cannot cross-reference text contained in a file that is not in the 
same master document. 

Feature FrameMaker 6 Word 2000

Type Cross-reference 
markers

Field codes

Location of referenced item 
▼ Same file
▼ Different file

✔ 
✔ 

✔ 
✔ Same master document

Formats
▼ Standard set
▼ Custom

✔ 
✔ 

✔ 
no

Referenced items 
▼ Headings
▼ Captions
▼ Other

✔ 
✔ 

Any text item including 
autonumbers

✔ 
✔ 

Bookmarks, footnotes, 
endnotes, equations

▼ Headings ▼ Bookmarks
▼ Figures ▼ Footnotes
▼ Tables ▼ Endnotes
▼ Numbered items ▼ Equations
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Word limits the contents of the reference. For example, you can cross-reference the 
heading number, heading text, or page number, but not all three in a single reference. 
To display all three items, you must insert three cross-references.

Variables

FrameMaker There are two types of variables: system and user. Variables consist of a name and a 
definition. 

By default, each document includes a set of 18 system variables that allow you to 
display information that FrameMaker generates. System variable definitions contain 
text, one or more FrameMaker building blocks, or a combination of the two. You 
cannot add, delete, or rename system variables. You can modify system variables, but 
should do so only when absolutely necessary.

You can add an unlimited number of user variables. Each variable can be no longer 
than 255 characters. You can delete or rename user variables. User variable definitions 
contain text. You can include character formats, but be aware that the formatting is 
included in the 255 character maximum. You cannot use system variable building 
blocks in user variables.

User variables are very useful for book titles, version numbers, product names, or any 
other text that appears in multiple places. You can also use variables for longer 
repeated text, such as confidential or copyright text that appears in every footer. 

FrameMaker ignores variables when you perform Find/Change operations on text. 
You can search for variables by selecting Any Variable or Variable of Name from the 
Find dialog.

Word There are several ways to create variables in Word documents. Most involve setting 
field codes and then referencing that field code. We have found that the easiest way to 
create and modify document variables is setting custom document properties and 
referencing them with DocProperty field codes. 

Word provides a default set of 27 document properties, all of which are initially 
empty. To use a predefined property, you must first assign a value and type to the 
property. You can also create your own document properties and change the values 
contained in any of the document properties. To use the document property in the 
text, you insert a DocProperty field code that references the document property name. 

While Word�s character shortcuts do not appear to work in the Document Properties 
dialog box, they do work in the Field Code dialog box. Changes to the character 
formatting apply to the entire property.

Feature FrameMaker 6 Word 2000

Predefined ✔ ✔ (Document properties)

Custom ✔ ✔ 

Formatting options ✔ ✔ 
Word 2000 vs. FrameMaker 6.0 28
June 16, 2004 Copyright © 1990-2004 Expert Support Inc.  All rights reserved.



Version 2.0
Revision Management

FrameMaker There are two parts to FrameMaker�s revision management: change bars and 
document comparison.

Change bars identify new or modified text in a file. You can specify the position of the 
change bars on the page. The options are:

▼ Left of Column

▼ Right of Column

▼ Side Closer to Page Edge

▼ Side Farther from Page Edge

In addition, you can specify the color to use, the thickness of the line, and the distance 
from the text column. If you select automatic change bars, FrameMaker flags the 
changes as you type. If you do not want to use automatic change bars, you can flag 
individual paragraphs or portions of text with change bars using the Change Bar font 
option.

FrameMaker�s change bars can be useful, but are applied in sometimes odd and 
annoying ways. For example, if you use variables and you import variable values, 
FrameMaker flags every line that uses variables with change bars even if none of the 
values actually changed. If the variables appear on the master pages, FrameMaker 
flags them, too. If you add or change markers (or, in some cases, cross-references), 
FrameMaker does not flag them with change bars.

FrameMaker�s document comparison utility allows you to compare two versions of a 
document, generate a summary report that lists all changes, and create a composite 
document (optional). You can use the following options:

▼ Flag the differences with change bars

▼ Identify inserted and deleted text with different conditional text tags

▼ Insert hypertext links to original files for each individual revision

You can only accept changes as a whole using the Clear Change Bars option. To 
review changes individually, you must scroll through file and edit. 

Feature FrameMaker 6 Word 2000

Change bars ✔ ✔ 

Change bars while typing ✔ ✔ 

Specify location of change bars ✔ ✔ 

Compare documents ✔ ✔ 

Flag text as inserted or deleted using conditional text automatically when 
version control is on
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Word The Track Changes facility marks changes in a document using revision marks. You 
can assign different colors to each writer or reviewer of a document to track each 
persons changes. You can accept or reject all revisions or step through each revision 
and accept or reject them individually. You can also specify a few parameters for 
searching through revisions.

You can specify a separate color for changed character formats. This feature is useful 
for reviewers who have seen earlier versions of the document: it�s nice to see that only 
a single word has changed and not an entire line or paragraph.

Change bars are fixed in size and position (except choices for left/right/outside). You 
can specify the color of the change bars.

You can compare versions of a document and have Word flag new and deleted text 
and apply change bars. Word applies the notations to newer file (or file of your 
choice); it does not have the summary file feature.

Viewing Documents

FrameMaker You can view FrameMaker documents only as they will appear on the page; this 
display is more exact than Word�s display. Split screen not supported. You can turn 
off display of graphics for quick redrawing onscreen. 

You can zoom the page in or out. This option is very useful for minor adjustments to 
illustrations, for reading small fonts sizes online, and for viewing page on a smaller 
screen. You can also use this feature to view facing pages side-by-side by adjusting 
the zoom percentage to a smaller size.

FrameMaker provider several options for units of measurement in addition to inches, 
millimeters, and centimeters. Points and Picas are particularly useful when you need 
to match specific measurements.

Feature FrameMaker 6 Word 2000

View Modes
▼ Unformatted (Normal)
▼ Formatted (Page Layout)
▼ Outline

no
✔ 
no

✔ 
✔ 
✔ 

Split screen no ✔ 

Facing pages ✔ ✔ Print Preview

Turn off graphic display ✔ ✔ 

Zoom display ✔ ✔ 

Units of measurement
▼ Inches
▼ Centimeters
▼ Millimeters
▼ Points
▼ Picas
▼ Other

✔ 
✔ 
✔ 
✔ 
✔ 

Didots, Ciceros

✔ 
✔ 
✔ 
✔ 
✔ 

Pixels
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Word You can view and edit in Page Layout, Normal, or Outline view. 

▼ Page Layout view shows pages (almost) exactly as they appear. Sometimes what 
you see is not what you get. For example, online page breaks might not match the 
hard copy print out.

▼ Normal view allows you to concentrate on the text content without displaying the 
intervening page breaks and margins, although everything else appears very close 
to reality.

▼ Outline view allows you to see the structure of the document, using indents to 
show the relationship of the headings and body text to each other. 

In addition, you can use Page Preview to see a close-to-exact rendition of the 
document. Page Preview allows you to view facing pages or multiple pages as they 
will print. There are a few minor problems with some Windows print drivers and 
document that use the �page n of n� format for page numbers.

You can zoom the page in or out. You can use this feature to display facing pages. You 
can also split the screen horizontally and view two random parts of same document 
simultaneously.

Printing

FrameMaker When you print FrameMaker documents, you can specify the following options:

In addition, you can print all files in a book or only those selected in the book 
window.

Feature FrameMaker 6 Word 2000

Collate output ✔ ✔ 

Color separations ✔ no

Multiple copies ✔ ✔ 

Page Range ✔ All or one range ✔ All, current page, 
multiple ranges

Registration/crop marks ✔ no

Thumbnails ✔ ✔ 

▼ Collate ▼ Print color separations
▼ Even-numbered pages only ▼ Print only to file
▼ Generate PDF data (print to file) ▼ Registration marks�Western or 

Tombo
▼ Last sheet first ▼ Scale percentage
▼ Low resolution images ▼ Skip blank pages
▼ Number of copies ▼ Spot Color as black/white
▼ Odd-numbered pages only ▼ Thumbnails (rows x columns)
▼ Page range�all or one range
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FrameMaker has more flexibility when producing hardcopy documents for print 
vendors.

Word When you print a Word document, you can specify the following options:

Word has more flexibility for printing page ranges and printing data that is normally 
hidden in printouts.

Portability 

FrameMaker FrameMaker is very portable among platforms. Adobe has implemented keyboard 
shortcuts that work on all platforms, as well as maintaining the familiar platform-
specific shortcuts that long-time FrameMaker users know and love. The user interface 
on all platforms is essentially the same. The primary portability issues are with 
graphics and font names. 

Many fonts have different names on the Mac and Windows. For example, Arial on 
Windows is ArialMT on the Mac. This name change presents problems when moving 
a document between platforms, and results in FrameMaker considering the fonts as 
�missing.� If a document must be moved regularly between platforms, we 
recommend that you maintain templates on each platform that use the correct fonts 
for that platform. When you move a document to a new platform, you can import the 
formats from that platform�s template before working on the document.

Most graphics work well in FrameMaker across platforms, including TIFF, GIF, and 
JPG. BMP graphics work well in the Windows version, but display and print as gray 
boxes in the Mac version. EPS graphics saved with Mac previews display as gray 

▼ Collate ▼ Pages per sheet (thumbnails)
▼ Draft output ▼ Print data only for forms
▼ Even-numbered pages only ▼ Print to file
▼ Number of copies ▼ Reverse print order
▼ Odd-numbered pages only ▼ Scale percentage
▼ Page range�all, current page, 

multiple ranges
▼ Print field codes, hidden text, and 

drawing objects
▼ Print document, document properties, 

comments, styles, autoText entries, or 
key assignments

Feature FrameMaker 6 Word 2000

Platforms
▼ Windows
▼ Mac
▼ UNIX/Solaris

✔ 
✔ 
✔ 

✔ 
✔ 
no

Portable between platforms ✔ ✔ 

Note: Both applications have standard platform problems with font names, plus display 
problems with nonsupported graphic formats.
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boxes in the Windows version; EPS graphics saved with PC previews, display and 
print in both versions.

Word Microsoft produces Windows and Mac versions of Word; it does not have a UNIX 
version. The Windows and Mac version numbers are not identical: The user interface 
for Word 2000 for Windows is very similar to Word 2001 for the Mac. There are some 
font issues moving files between platforms, but they are not as high-profile as in 
FrameMaker.

Moving files between platforms works well. The application contains built-in filters 
that allow you to move documents in earlier versions to Word 2000 with few 
problems. 

Templates

FrameMaker A FrameMaker template is used �as a foundation for formatting other documents.� 
There is no distinction between FrameMaker documents and templates�you can use 
any FrameMaker document as a template.You create a new file using a predefined 
template or by using any FrameMaker document. The new document contains the 
exact formats (and content) as the template or document you used to create it. 

FrameMaker does not automatically update documents when you change a template. 
However, you can import formats (see below) to apply the changes to a document. 

One of its strengths is the ability to import formats from any other FrameMaker 
document. FrameMaker allows you to choose which type of elements to import (see 
list in the above table). In addition, you can specify whether to remove manual page 
breaks and whether to override the formats contained in the active document. For 
example, you can choose to import the page layouts and remove manual page breaks, 
but not import the paragraph formats or remove format overrides. 

Feature FrameMaker 6 Word 2000

Create new files from
▼ Template file
▼ Existing documents

✔ 
✔ 

✔ 
✔ 

Import (merge) template features
▼ Autotext entries
▼ Character formats
▼ Color definitions
▼ Conditional text settings
▼ Cross-reference formats
▼ Document properties
▼ Macros
▼ Math definitions
▼ Page layouts
▼ Paragraph formats
▼ Reference pages
▼ Table definitions
▼ Toolbars
▼ Variable definitions

no
✔ 
✔ 
✔ 
✔ 
✔ 
no
✔ 
✔ 
✔ 
✔ 
✔ 
no
✔ 

✔ 
✔ 
no
no
no
no
✔ 
no
no
✔ 
no
no
✔ 
no
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FrameMaker�s template functionality is flexible and well-defined. This feature allows 
you to ensure that the document design is consistent from one file to another.

Word A Word template is �a special kind of document that provides basic tools for shaping 
a final document.� Word template names end with the .dot extension. By default, 
Word assumes that you will create a new document by using one of the templates 
contained in the Templates directory. You can also create a new document by opening 
a Word document and saving it with a new name.

Word allows you to attach a template to a document. When you attach a template, 
you make the paragraph and character styles, tool bars, and autotext entries available 
to the current document. However, Word does not apply the attached template�s 
styles to the document; you must merge them.

Word allows you to merge paragraph and character styles, tool bars, and autotext 
from a template or Word document. When you merge styles, Word overwrites the 
existing styles with the definitions from the specified template or document

Word does not automatically update documents when you change a template. You 
must merge the styles from the updated template to include the changes in a 
document.

The most annoying thing about Word�s template feature is that it does not allow you 
to merge page layouts. You must manually set the page size and margins when 
applying a new template to an existing document.

Additional Functionality

Conditional Text

FrameMaker You use conditional text when you need to prepare different versions of a document 
and you want to keep the versions in one file. For example, if you have a document 
that you deliver both in hardcopy and in HTML, you can flag some text to appear 
only in the hard copy document. When you produce the HTML version, you hide all 
conditional indicators for hardcopy documents.

Feature FrameMaker 6 Word 2000

Conditional (hidden) text ✔ no

Embedded hyperlinks ✔ ✔ 

Outlining ✔ Using template formats ✔ 

Smart Quotes ✔ ✔ 

Smart Spaces ✔ ✔ 

Sorting
▼ Table cells
▼ Text

✔ 
no

✔ 
✔ 
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By default, FrameMaker defines the Comment condition tag. You can define as many 
condition tags as you need and of any type you need. For example, your document 
can contain tags for platforms (UNIX, PC, Mac), document versions (hardcopy, 
HTML, PDF), and other purposes (Confidential, Draft, Reviewer Comment). You can 
turn them on and off in any combination. In addition, you can choose formatting 
options for each tag. This flexibility allows you to maintain only a single document 
with several flavors when most content is identical.

Word Word does not contain a comparable feature to FrameMaker�s conditional text. It does 
provide the following options:

▼ Hidden Text: You can flag text to be either hidden or not. When displayed, is 
underlined with dotted line.

▼ Comments: You can insert a comment that displays as a screen tip above the text. 
You can print comments by setting an option in Print options.

Embedded Hyperlinks

FrameMaker You embed hyperlinks in a FrameMaker document in the following ways:

▼ Cross-references: When you convert documents to HTML or PDF, cross-references 
automatically become hyperlinks.

▼ Contents, lists, and indexes: You can set an option to insert hypertext markers each 
time the files generate. When you convert the documents to HTML or PDF, the 
hypertext markers become hyperlinks in the document.

▼ Hypertext markers: You can insert hypertext markers that link to specific pages 
within the current file or in an external file, URLs, contain mailto information, 
open other applications, or contain HTML code to pass through to the HTML ver-
sion of the document. You can place hypertext markers in text areas or in graphics; 
when placing hypertext in images, you can set up matrixes that convert to image 
maps in HTML.You can also set hypertext markers on Master pages so the links 
apply to all pages of that type. When you convert the document to HTML or PDF, 
the markers become hyperlinks (with some limitations).

To test hypertext links, you can set the entire document to view-only or use keyboard 
shortcuts on individual links. You can view a list of hypertext markers to manually 
check for missing links.

One disadvantage is that you must type the content of the marker individually. You 
can use copy-paste to use the same marker content for multiple markers or to place 
identical markers in multiple locations.

Word You embed hyperlinks in a Word document in the following ways:

▼ Cross-references: When you insert cross-references, they automatically become 
hyperlinks. When you click on a cross-reference, Word takes you to the source 
text. 

▼ Contents, lists of figures and tables, and indexes: When you insert one of these 
items, each entry in the list becomes a hyperlink. When you click on an entry, 
Word takes you to the source text.
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▼ Hyperlinks: You can insert hyperlinks to specific locations in the file or in an exter-
nal file, URLs, or email addresses. Using the Hyperlink dialog box, you can place 
hyperlinks in text or graphics. You cannot set up an image map using this facility. 
You can also use drag-and-drop to create hyperlinks.

Hyperlinks are active, by default. This setting allows you test links as soon as you 
insert them. 

Outlining

FrameMaker You can create an outline document using numbered formats. FrameMaker contains 
three sample templates with formats that provide a starting point. FrameMaker does 
not have an outline view or an outline facility similar to Word�s.

Word You can easily organize a document into outline levels using the Outline View. To 
display numbered outline levels, you apply outline numbering to the heading styles. 
You can assign other styles to use outline levels as needed.

Smart Quotes and Smart Spaces

FrameMaker Smart Quotes (curly quotes) and Smart Spaces are two text options you can set in 
FrameMaker documents. Both options are associated with the document.

▼ Smart Quotes: By default, this option is set when you create a new document. If 
your document contains a lot of computer text and you need straight quotes, you 
can turn off Smart Quotes. If you need straight quotes infrequently in a document, 
you can use a keyboard shortcut to type them.

▼ Smart Spaces: This option prevents you from typing multiple spaces in a row. By 
default, this option is off when you create a new document. When Smart Spaces is 
set, you can automatically change multiple spaces to a single space by typing a 
space in the area. This option prevents stray embedded spaces, including those fol-
lowing the end of sentence. When this option is set, the spelling checker alerts you 
to the presence of multiple spaces.

Word Word contains a Smart Quotes option. It does not have a true Smart Spaces option, 
but Smart Cut and Paste handles spaces while deleting or inserting text. 

▼ Smart Quotes: This option is associated with the user, not the document. Note that 
the override settings for any text you paste into a Word document is not automati-
cally updated, so straight quotes can slip by even if the Smart Quotes feature is set. 

▼ Smart Cut and Paste: This option is associated with the user, not the document. 
When set, Word can remove an extra space before a period or add a space between 
two words.

Sorting

FrameMaker Version 6.0 of FrameMaker added the feature of sorting table cells. You can sort table 
content alphabetically in either ascending or descending order. You must specify the 
column on which to base the sort. You can also specify that FrameMaker consider the 
content�s case when sorting.
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FrameMaker still does not contain the facility to sort body text. You can get around 
this by placing the text in a table and sorting the table cells.

Word You can sort almost anything in Word, including table cells, body text paragraphs, 
and lists. This feature allows you to sort lists or table contents in alphabetic order, in 
either ascending or descending order. When sorting table content, you specify the 
column on which to base the sort.
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